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Navigate to the main page of the class: https://
astamm.github.io/data-science-with-r/. 
Download 05-Report-Exercises.qmd and 05-Report-
Parameters.qmd from the outline table and open them.
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Quarto
Plain text file with 3 types of content:

A YAML header 
surrounded by 

— — —

Code chunks 
surrounded by 

```

Text in 
markdown
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How it works
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md

ioslides 
slidy, Beamer

Microsoft Word

Powerpoint

knitr pandoc
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Logistics

knitr runs the document in a fresh R session, 
which means you need to load the libraries 
that the document uses in the document1
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Logistics

Knitr runs the document in a fresh R session, 
which means you need to load the libraries 
that the document uses in the document1
Objects made in one code chunk will be 
available to code in later code chunks.2
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knitr is  
multi-lingual!

SAS 
python 
more
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Some python code,
```{python}
x = 'hello, python 
world!'
print(x)
print(x.split(' '))
```

engine
To embed non R code, change the chunk 
label from r to the language to use.python

https://creativecommons.org/licenses/by-sa/4.0/


Reticulate
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bookdown.org/yihui/rmarkdown/
ONLINE, FREE
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Markdown

Text in 
markdown
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# Header 1  
## Header 2
### Header 3
#### Header 4
##### Header 5
###### Header 6

Headers
Use # to create headers.  
Multiple #’s create lower level headers.

15
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Text  
_italics_  
**bold**  
`code`  

Text
Text is rendered as plain text. Surround 
text with _, **, or ` to format it.

Add two spaces at 
the end of a line to 

start a new line
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Bullets

* bullet 1
* bullet 2

Numbered list

1. item 1
2. item 2

Lists
Use asterisks or dashs to make bullet points. 
Use numbers to make numbered lists.
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This is a 
[link](www.git.com).

Hyperlinks
Use brackets to denote a link. 
Place the URL in parentheses.
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![](images/1.png)
The RStudio logo.

Images
Use a link preceded by an ! to insert an image.  
The link text should be a URL (if the image is hosted 
online), or a file path (if the image is saved as a file)
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Equations
Write equations with latex math 
commands and surround them in $’s.

According to 
Einstein, 
$E=mc^{2}$

20
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According to 
Einstein, 

$$E=mc^{2}$$

Equation blocks
Use two $’s to make 
centered equation blocks.

21
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```{r results = 'asis'} 
knitr::kable(data, caption = "Table with kable”) 
``` 
```{r results = "asis"} 
print(xtable::xtable(data, caption = "Table with xtable”),  
            type = "html", html.table.attributes = "border=0")) 
``` 
```{r results = "asis"}  
stargazer::stargazer(data, type = "html", title = "Table  
                                            with stargazer") 
```

Plain text   
End a line with two spaces  
to start a new paragraph.   
*italics* and **bold**   
`verbatim code`   
sub/superscript^2^~2~   
~~strikethrough~~   
escaped: \* \_ \\   
endash: --, emdash: ---   
equation: $A = \pi*r^{2}$   
equation block: 

$$E = mc^{2}$$ 

> block quote   

# Header1  {#anchor} 

## Header 2  {#css_id} 

### Header 3  {.css_class} 

#### Header 4   

##### Header 5   

###### Header 6   

<!--Text comment--> 

\textbf{Tex ignored in HTML} 
<em>HTML ignored in pdfs</em>  

<http://www.rstudio.com>   
[link](www.rstudio.com)   
Jump to [Header 1](#anchor)   
image:  

![Caption](smallorb.png) 

* unordered list 
    + sub-item 1 
    + sub-item 2 
        - sub-sub-item 1 
   
* item 2 

    Continued (indent 4 spaces) 
     
1. ordered list 
2. item 2 
    i) sub-item 1 
         A.  sub-sub-item 1 

(@)  A list whose numbering 

continues after 

(@)  an interruption 

Term 1 

:   Definition 1 

| Right | Left | Default | Center | 
|------:|:-----|---------|:------:| 
|   12  |  12  |    12   |    12  | 
|  123  |  123 |   123   |   123  | 
|    1  |    1 |     1   |     1  | 

- slide bullet 1 
- slide bullet 2   

(>- to have bullets appear on click) 

horizontal rule/slide break:  

*** 

A footnote [^1] 

[^1]: Here is the footnote. 

Write with syntax on the left to create effect on right (after render)
Pandoc’s Markdown Set render options with YAML

When you render, R Markdown  
1. runs the R code, embeds results and text into .md file with knitr  
2. then converts the .md file into the finished format with pandoc

Create a Reusable Template
1. Create a new package with a inst/rmarkdown/templates 
directory 
2. In the directory, Place a folder that contains: 
template.yaml (see below)  
skeleton.Rmd (contents of the template) 
any supporting files 
3. Install the package 
4. Access template in wizard at File ▶ New File ▶ R Markdown  
template.yaml

Set a document’s 
default output format 
in the YAML header:

--- 
output: html_document 
--- 
# Body

output value creates
html_document html
pdf_document pdf (requires Tex )
word_document Microsoft Word (.docx)
odt_document OpenDocument Text
rtf_document Rich Text Format
md_document Markdown
github_document Github compatible markdown
ioslides_presentation ioslides HTML slides
slidy_presentation slidy HTML slides
beamer_presentation Beamer pdf slides (requires Tex)

Customize output with 
sub-options (listed to 
the right):

--- 
output: html_document: 
  code_folding: hide 
  toc_float: TRUE 
--- 
# Body

Indent 4 
spaces

Indent 2 
spaces

html tabsets 
Use tablet css class to place sub-headers into tabs

# Tabset {.tabset .tabset-fade .tabset-pills} 
## Tab 1 
text 1 
## Tab 2 
text 2 
### End tabset

Tabset 

text 1 
End tabset

  Tab 1   Tab 2

--- 
name: My Template 
—

sub-option description
citation_package The LaTeX package to process citations, natbib, biblatex or none X X X
code_folding Let readers to toggle the display of R code, "none", "hide", or "show" X
colortheme Beamer color theme to use X
css CSS file to use to style document X X X
dev Graphics device to use for figure output (e.g. "png") X X X X X X X
duration Add a countdown timer (in minutes) to footer of slides X
fig_caption Should figures be rendered with captions? X X X X X X X
fig_height, fig_width Default figure height and width  (in inches) for document X X X X X X X X X X
highlight Syntax highlighting: "tango", "pygments", "kate","zenburn", "textmate" X X X X X
includes File of content to place in document (in_header, before_body, after_body) X X X X X X X X
incremental Should bullets appear one at a time (on presenter mouse clicks)? X X X
keep_md Save a copy of .md file that contains knitr output X X X X X X
keep_tex Save a copy of .tex file that contains knitr output X X
latex_engine Engine to render latex, "pdflatex", "xelatex", or "lualatex" X X
lib_dir Directory of dependency files to use (Bootstrap, MathJax, etc.) X X X
mathjax Set to local or a URL to use a local/URL version of MathJax to render equations X X X
md_extensions Markdown extensions to add to default definition or R Markdown X X X X X X X X X X
number_sections Add section numbering to headers X X
pandoc_args Additional arguments to pass to Pandoc X X X X X X X X X X
preserve_yaml Preserve YAML front matter in final document? X
reference_docx docx file whose styles should be copied when producing docx output X
self_contained Embed dependencies into the doc X X X
slide_level The lowest heading level that defines individual slides X
smaller Use the smaller font size in the presentation? X
smart Convert straight quotes to curly, dashes to em-dashes, … to ellipses, etc. X X X
template Pandoc template to use when rendering file quarterly_report.html). X X X X X
theme Bootswatch or Beamer theme to use for page X X
toc Add a table of contents at start of document X X X X X X X
toc_depth The lowest level of headings to add to table of contents X X X X X X
toc_float Float the table of contents to the left of the main content X
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Table Suggestions Citations and Bibliographies
Several functions format R data into tables

Learn more in  
the stargazer, 

xtable, and knitr 
packages.

Create citations with .bib, .bibtex, .copac, .enl, .json,  
.medline, .mods, .ris, .wos, and .xml files 

1. Set bibliography file and CSL 1.0  
Style file (optional) in the YAML header 

2.  Use citation keys in text 

3.  Render. Bibliography will be  
added to end of document

Smith cited [@smith04]. 
Smith cited without author [-@smith04]. 
@smith04 cited in line.

--- 
bibliography: refs.bib  
csl: style.csl 
---

data <- faithful[1:4, ]

RStudio® is a trademark of RStudio, Inc.  •  CC BY SA  RStudio •  info@rstudio.com  •  844-448-1212 • rstudio.com •  Learn more at rmarkdown.rstudio.com  •  rmarkdown  1.6  •  Updated: 2016-02

```{r results = 'asis'} 
knitr::kable(data, caption = "Table with kable”) 
``` 
```{r results = "asis"} 
print(xtable::xtable(data, caption = "Table with xtable”),  
            type = "html", html.table.attributes = "border=0")) 
``` 
```{r results = "asis"}  
stargazer::stargazer(data, type = "html", title = "Table  
                                            with stargazer") 
```

Plain text   
End a line with two spaces  
to start a new paragraph.   
*italics* and **bold**   
`verbatim code`   
sub/superscript^2^~2~   
~~strikethrough~~   
escaped: \* \_ \\   
endash: --, emdash: ---   
equation: $A = \pi*r^{2}$   
equation block: 

$$E = mc^{2}$$ 

> block quote   

# Header1  {#anchor} 

## Header 2  {#css_id} 

### Header 3  {.css_class} 

#### Header 4   

##### Header 5   

###### Header 6   

<!--Text comment--> 

\textbf{Tex ignored in HTML} 
<em>HTML ignored in pdfs</em>  

<http://www.rstudio.com>   
[link](www.rstudio.com)   
Jump to [Header 1](#anchor)   
image:  

![Caption](smallorb.png) 
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    Continued (indent 4 spaces) 
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(@)  A list whose numbering 

continues after 

(@)  an interruption 

Term 1 

:   Definition 1 

| Right | Left | Default | Center | 
|------:|:-----|---------|:------:| 
|   12  |  12  |    12   |    12  | 
|  123  |  123 |   123   |   123  | 
|    1  |    1 |     1   |     1  | 

- slide bullet 1 
- slide bullet 2   

(>- to have bullets appear on click) 

horizontal rule/slide break:  

*** 

A footnote [^1] 

[^1]: Here is the footnote. 

Write with syntax on the left to create effect on right (after render)
Pandoc’s Markdown Set render options with YAML

When you render, R Markdown  
1. runs the R code, embeds results and text into .md file with knitr  
2. then converts the .md file into the finished format with pandoc

Create a Reusable Template
1. Create a new package with a inst/rmarkdown/templates 
directory 
2. In the directory, Place a folder that contains: 
template.yaml (see below) 
skeleton.Rmd (contents of the template) 
any supporting files 
3. Install the package 
4. Access template in wizard at File ▶ New File ▶ R Markdown  
template.yaml

Set a document’s 
default output format 
in the YAML header:

--- 
output: html_document 
--- 
# Body

output value creates
html_document html
pdf_document pdf (requires Tex )
word_document Microsoft Word (.docx)
odt_document OpenDocument Text
rtf_document Rich Text Format
md_document Markdown
github_document Github compatible markdown
ioslides_presentation ioslides HTML slides
slidy_presentation slidy HTML slides
beamer_presentation Beamer pdf slides (requires Tex)

Customize output with 
sub-options (listed to 
the right):

--- 
output: html_document: 
  code_folding: hide 
  toc_float: TRUE 
--- 
# Body

Indent 4 
spaces

Indent 2 
spaces

html tabsets 
Use tablet css class to place sub-headers into tabs

# Tabset {.tabset .tabset-fade .tabset-pills} 
## Tab 1 
text 1 
## Tab 2 
text 2 
### End tabset

Tabset 

text 1 
End tabset

  Tab 1   Tab 2

--- 
name: My Template 
—

sub-option description
citation_package The LaTeX package to process citations, natbib, biblatex or none X X X
code_folding Let readers to toggle the display of R code, "none", "hide", or "show" X
colortheme Beamer color theme to use X
css CSS file to use to style document X X X
dev Graphics device to use for figure output (e.g. "png") X X X X X X X
duration Add a countdown timer (in minutes) to footer of slides X
fig_caption Should figures be rendered with captions? X X X X X X X
fig_height, fig_width Default figure height and width  (in inches) for document X X X X X X X X X X
highlight Syntax highlighting: "tango", "pygments", "kate","zenburn", "textmate" X X X X X
includes File of content to place in document (in_header, before_body, after_body) X X X X X X X X
incremental Should bullets appear one at a time (on presenter mouse clicks)? X X X
keep_md Save a copy of .md file that contains knitr output X X X X X X
keep_tex Save a copy of .tex file that contains knitr output X X
latex_engine Engine to render latex, "pdflatex", "xelatex", or "lualatex" X X
lib_dir Directory of dependency files to use (Bootstrap, MathJax, etc.) X X X
mathjax Set to local or a URL to use a local/URL version of MathJax to render equations X X X
md_extensions Markdown extensions to add to default definition or R Markdown X X X X X X X X X X
number_sections Add section numbering to headers X X
pandoc_args Additional arguments to pass to Pandoc X X X X X X X X X X
preserve_yaml Preserve YAML front matter in final document? X
reference_docx docx file whose styles should be copied when producing docx output X
self_contained Embed dependencies into the doc X X X
slide_level The lowest heading level that defines individual slides X
smaller Use the smaller font size in the presentation? X
smart Convert straight quotes to curly, dashes to em-dashes, … to ellipses, etc. X X X
template Pandoc template to use when rendering file quarterly_report.html). X X X X X
theme Bootswatch or Beamer theme to use for page X X
toc Add a table of contents at start of document X X X X X X X
toc_depth The lowest level of headings to add to table of contents X X X X X X
toc_float Float the table of contents to the left of the main content X
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Table Suggestions Citations and Bibliographies
Several functions format R data into tables

Learn more in  
the stargazer, 

xtable, and knitr 
packages.

Create citations with .bib, .bibtex, .copac, .enl, .json,  
.medline, .mods, .ris, .wos, and .xml files 

1. Set bibliography file and CSL 1.0  
Style file (optional) in the YAML header 

2.  Use citation keys in text 

3.  Render. Bibliography will be  
added to end of document

Smith cited [@smith04]. 
Smith cited without author [-@smith04]. 
@smith04 cited in line.

--- 
bibliography: refs.bib  
csl: style.csl 
---

data <- faithful[1:4, ]

RStudio® is a trademark of RStudio, Inc.  •  CC BY SA  RStudio •  info@rstudio.com  •  844-448-1212 • rstudio.com •  Learn more at rmarkdown.rstudio.com  •  rmarkdown  1.6  •  Updated: 2016-02

rmarkdown

Markdown
Dictionary of formatting cues.

on back of 

RMarkdown 

cheat sheet

22



IDE Reference
Go to Help > Markdown Quick Reference

opens 
here



Code 

Code chunks 
surrounded by 

```
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Code chunks
Insert a chunk of R code with  

When you render the report, Quarto will 
run the code and include its results. 
Quarto will also remove the ```{r} and 
```.

```{r}
# some code
```

25

https://creativecommons.org/licenses/by-sa/4.0/


(PC)

(Mac)

CC BY-SA RStudio

Code chunks

AltCtrl i+ +

Opt⌘ i+ +

Insert a chunk of R code with
```{r}
# some code
```

https://creativecommons.org/licenses/by-sa/4.0/
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chunk options
By default, Quarto includes both the code 
and its results

Here’s some code
```{r}
dim(iris)
```

27
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Here’s some code
```{r}
#| echo: false
dim(iris)
```

echo
Add options in the chunk by starting the line with `#|`.   
echo: false hides the code.

Very useful  

for p
lots

28
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Here’s some code
```{r}
#| eval: false
dim(iris)
```

eval
eval: false prevents the code from being run. As a 
result, no results will be displayed with the code.
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Here’s some code
```{r}
#| include: false
dim(iris)
```

include
include: false runs the code, but prevents both the 
code and the results from appearing (e.g. to setup).
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fig-height, fig-width

Here’s a plot
```{r}
#| echo: false
#| fig-width: 3
#| fig-height: 5
hist(iris[[2]])
```

Specify the dimension of plots (in inches) with fig-width and 
fig-height. Separate multiple arguments with commas.

31
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Pop Quiz

Do you notice the TODOs in  
05-Report-Exercises.qmd?

32

Do you notice the long setup chunk?
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Inline code

Today is 
`r Sys.Date()`.

Place code in a sentence with `r  <code>`. 
Quarto will replace the code with its results.

33
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Inline code
Code whose results are inserted into the text.

Today is `r Sys.Date()`.

Code to run. Only the 
result will be included.

Surround 
with `r      `

34
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Your Turn 1
In 05-Report-Exercises.qmd: 

1. Replace every Garrett with your name 

2. Replace every TODO with inline R code 

3. Check that the setup chunk is not included with 
the output 

4. Ensure that only the output of the plot chunk is 
shown (not the code) 

5. Knit the document
35
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YAML 
A YAML header 
surrounded by 

— — —
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---
title: "Untitled"
author: "RStudio"
date: "February 4, 2015"
format: html
---
Text of document

YAML
A section of key:value pairs 
separated by dashed lines ———

https://creativecommons.org/licenses/by-sa/4.0/
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format
The format: field sets the format of the final report

https://creativecommons.org/licenses/by-sa/4.0/
https://quarto.org/docs/output-formats/all-formats.html
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Your Turn 2
Open 05-Report-Parameters.qmd.  

Render the document. 

Change the name property in the YAML 
header and re-render document. What 
happened?

40
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Parameters

---
title: "Untitled"
format: html
params:
  filename: "data.csv"
  symbol: "FB"
---

A list of values that you can call in R code chunks

elements and 
values

params list

colon

New line. 
Indented two 

spaces

41
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Using Parameters
Call parameter values as elements of 
the params list, params$num

--- 
params:
  num: 42
--- 
The value of the 
parameter is 
`r params$num`, e.g.

```{r}
params$num
``` 42
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names <- c("Alice", "Bob", "Cathy") 
for (nm in names) { 
  quarto::quarto_render( 
    input = "05_Report/05-Report-Parameters.qmd",  
    output_file = glue::glue("05_Report/05-Report-
{name}.html"),  
    execute_params = list(name = nm) 
  )   
}

quarto::quarto_render() + for

https://creativecommons.org/licenses/by-sa/4.0/
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Demo
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